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SYSTEM REQUIREMENTS

Below are the minimum system requirements to install and run the Wireless DK-5000
Mieruzzo Basic Software:

Processor Pentium 2 266MHz
Operating System Windows 7, 8, 8.1, 10
Disk Space Application: 50MB

Java Runtime Environment: 160MB

Memory 1GB

Microsoft Excel and Windows are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

=
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INSTALLING WIRELESS DK-5000 MIERUZZO BASIC SOFTWARE AND
DRIVER

1.1 WIRELESS DK-5000 MIERUZZO BASIC SOFTWARE INSTALLATION
1.1.1 Double-click or run the software installer.

_E Wireless DK-5000 Mieruzzo Basic
Software Setup Version 1.0 Build 3...
It 1 Wireless DE-5000 Mieruzzo Softw..

1.1.2 Select the language to use. Click OK to continue with the software installation.
‘Select Setup Lang

Select the language to use during the
installation:

|Engiish v

1.1.3 The Wireless DK-5000 Mieruzzo Basic Software Setup Wizard will start. Click Next to
continue with the software installation.
ﬁ%‘ Setup - Wireless DE-3000 Mieruzze Basic Software (=N

Welcome to the Wireless DK-5000
Mieruzzo Basic Software Setup
Wizard

This will install Wireless DE-5000 Mieruzzo Basic Software
version 1.0 on your computer,

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup,

Mext = ][ Cancel ]

N
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1.1.4 Read the License Agreement and select ‘| accept the agreement’ to proceed.

Setup - Wireless DE-3000 Mieruzzo

License Agreement
Flease read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

EMD-JSER. LICEMSE AGREEMENT (ELILA) -
LIME SEIKI Co.,LTD.(Hereinafter referred to as "LIME SEIKI™) grants you the right L4
to install and use copies of the SOFTWARE PRODUCT (Hereinafter referred to as
"SOFTWWARE™)

on your computer under following conditions,

1. COPYRIGHT

all title and intellectual property rights of SOFTWARE are owned by LINE SEIKI or
licensed

by suppliers, all rights of SOFTWARE are reserved by LIME SEIKI under applicable ™

@) I accept the agreement

(7)1 do not accept the agreement

< Back ][ Mext = ][ Cancel

1.1.5 Select the default installation folder or browse for a new location. Click Next to continue with

the software installation.

Setup - Wireless DK-5000 Mieruzzo Basic

Select Destination Location
Where should Wireless DK-5000 Mieruzzo Basic Software be installed?

l Setup will install Wireless DK-5000 Mieruzzo Basic Software into the following
folder.

To continue, dick Mext. If yvou would like to select a different folder, dick Browse.

{x86)Line Seiki\Mieruzzo\Wireless DK-5000 Mieruzzo Basic Software

At least 156.0 MB of free disk space is required.

< Back ]I Mext = I[ Cancel

@ LINE SEIKI 3




Wireless DK-5000 Series Mieruzzo Basic Software User's Manual

1.1.6 Select the default location of program’s shortcut or browse for a new location. Click Next to

continue with the software installation.

Setup - Wireless DKE-5000 Mieruzzo

Select Start Menu Folder "
Where should Setup place the program's shortouts?

| i Setup will create the program's shortouts in the following Start Menu folder.

To continue, dick Mext. If yvou would like to select a different folder, didk Browse.

Wireless DE-5000 Mieruzzo Basic Software

< Back ]I Mext = I[ Cancel

1.1.7 Select whether to create or not to create a desktop icon for the software via the checkbox.

Click Next to continue with the software installation.

Setup - Wireless DK-5000 =

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing Wireless
DK-5000 Mieruzzo Basic Software, then dick Mext.

Additional shortouts:
Create a desktop shortout

< Back " Mext = ][ Cancel
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1.1.8 Click Install to continue with the software installation.

Setup - Wireless DE-5000

Ready to Install

Setup is now ready to begin installing Wireless DK-5000 Mieruzzo Basic Software
on your computer.

Click Install to continue with the installation, or didk Back if you want to review or
change any settings.

Destination location: p
C:\Program Files (x36)\Line SeikiMieruzzo\Wireless DK-5000 Mieruzzo Basic 5

Start Menu folder:
Wireless DK-5000 Mieruzzo Basic Software

Additional tasks:
Additional shortouts:
Create a desktop shortcut

<Back || Instal | | cancel

A progress bar will show the installation progress.

Setup - Wireless DE-5000

Installing

Flease wait while Setup installs Wireless DK-5000 Mieruzzo Basic Software on
your computer.

Extracting files...
C:\...\WMieruzzo \Wireless DK-5000 Mieruzzo Basic Softwarejrellib\charsets. jar
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1.1.9 Wireless DK-5000 Series Device Driver Updater will open for the installation of necessary

device driver. Click Next to continue.

Wireless DK-3000 Series Device Driver Updater

Welcome to device installer.

your device.

To continue, click Meadt.

Mext =

This wizard will wallc you through updating the drivers for

Cancel

1.1.10 The following window will appear upon successful installation of the Wireless DK-5000

Series Device Driver. Click Finish to continue.

Wireless DK-3000 Series Device Driver Updater

Congratulations! You finished

device drivers.

came with instructions, please read them first.

installing your Wireless DK-5000

The drivers were successfully installed on this computer.

fou can now connect your device to this computer. F your device

Drriver Mame Status
W Line Seiki Co., ltd. www... Ready to use

Cancel
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1.1.11 Click FEinish to complete the software installation. If Launch Wireless DK-5000 Mieruzzo

Basic Software is checked, the software will automatically launch.

ﬁg Setup - Wireless DKE-5000 Mieruzzo Basic hﬂ

Completing the Wireless DK-5000
Mieruzzo Basic Software Setup

Wizard

Setup has finished installing Wireless DK-5000 Mieruzzo Basic
Software on your computer. The application may be launched
by selecting the installed shaortouts,

Click Finish to exit Setup.

Launch Wireless DK-5000 Mieruzzo Basic Software

1.1.12 See below image for the default view of the Wireless DK-5000 Mieruzzo Basic Software.

2% Wireless DK-5000 Mieruzzo Basic Software _X l..

File Device Window Help

Auto-Acquire Acquire All Records l ¥ Connection I Export All Records
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1.2 MIERUZZO SERIES WIRELESS/SENSON DEVICE DRIVER

1.2.1 The correct Mieruzzo Series Wireless/Sensor Device Driver is installed together with the

Wireless DK-5000 Mieruzzo Basic Software.

In case there is a need to re-install the device driver, it can be found by selecting the correct

driver located in the installation directory of the software.

<l
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CONNECTING AND DISCONNECTING DEVICES

2.1 CONNECTING AND CONFIGURING A WIRELESS DEVICE

2.1.1 When a wireless device is physically connected to the computer via a USB cable, click

Window in the menu bar, then select Preferences (Window > Preferences)

—
2, Wireless DK-5000 Mieruzzo ﬁ m_

File Device | Window | Help
2 Preferences  Ctrl+5hift+F [‘

- 1100 (e (1)1

2.1.2 In the Device Configuration Preference, you will see a drop-down button that will list all

wireless devices that are currently connected with their type, ID Name, and COM Port
Connection. If there is multiple items in the list, select the device you want to connect and

click Connect button. Click Refresh button to refresh the list of devices.

Ll ™y
% Device Configuration EM

Device Configuration Device Configuration - - v
Please select from available Wireless accessaories,
WPRANPO - Wireless001 : COMA2 - Connect
WPANPO - Wireless001 : COM42 : :
l —mmwmmn—rmwmﬂmrj View Details

Connection Failure:

rﬂ '1
=y Error ﬁ

Mo target Wireless Accessory connected. Please make sure you connected a Wireless
Accessory.

Error Code: 25
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2.1.3 Once successfully connected to the wireless device, the Device Configuration will be

enabled for editing.

f @

2% Device Configuration

Device Configuration Device Configuration - - -

Pleasze =zelect from available Wireless accessories, Refresh

| WPANPO - Parent: COM42 ~|| Connect |
| ViewLast Configuration | | Firmware Version | | View Details |
Channel
PANID
ID Name
SET SAVE

| ok || cancel

NOTE:
(a) Parent address textbox will be disabled if selected device is parent type.

(b) Child address textbox will be disabled if selected device is child type.

Channel and PAN ID — must be the same for parent and child device.

ID Name — is the wireless device identifier.
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2.1.4 Input the device configuration and click Set button. Each field will be highlighted after setting

the configuration, GREEN for successful and RED for failed.

The user needs to input on the fields with red highlight and click Set button until all fields are

successfully set.

Channel

=)
=
=
]

ID Mame
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2.1.5 Once the fields are all set, click Save button to save the configuration on the device.

Save successful: Restart device to apply changes.

oo .
=3 Information >

Configuration saved! Some changes will not take effect until you reboot your
Wireless accessory.

Save Failed: Click Set and Save again.

& Error >

Medule settings failed. Please set again and save within 5 seconds,

Error Code; 12

Save Failed: Device is disconnected. Reconnect the device and. Click Set and Save again.

Some values might have to be reentered.

(=]
= Error >

Unable to connect to target.

Upon successful configuration, the Preferences dialog will close and you can now use the

device to connect to the application.
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2.1.6 To view the details of the current connected device, click View Details button.

Device Details . u
Channel
25
PAM ID
ABCDEF

MAC Address (Wireless Coordinator)
13A20040D28F34A

MAC Address (Wireless End Device)
13420040E56060

ID Mame
Wireless001

Load Details ] ’ Close

Click Load Details button to load the details to the configuration page and Close button to close
the Device Details dialog.

2.1.7 To view the last configuration used in the PC, click View Last Configuration.

View Last Configuration S
Channel
25
PAMID
ABCDEF

MAC Address (Wireless Coordinator)
40D28F34

MAC Address (Wireless End Device)
40E56060

ID Mame
Wireless001

Load Details l ’ Cloze

Click Load Details button to load the details to the configuration page and Close button to close
the Last Saved Configuration dialog.

@ LINE SEIKI




Wireless DK-5000 Series Mieruzzo Basic Software User's Manual

2.1.8 To view the firmware version of the connected device, click Firmware Version button.

[=31] - -
3 Firmware Version X

@ Mieruzrzo Series Wireless/ Sensor Device firmware v.1.0 build 020

2.2 CONNECT A DK-5000 DEVICE
2.2.1 Connect the Wireless Coordinator device to the computer via USB cable. Connect a DK-

5000 device to a Wireless End device.

To connect to child device, go to Device menu and select Connection.

iy Wireless D!(—m

File [Device | Window Help
7 Device Settings ]
ﬂ Connection Ctrl+0 Acq
Disconnect Ctrl+Shift+C :
Sync Time Ctrl+T
Edit Labels
Firmware Version Ctrl+R

Or click Connection button.

File Device Window Help

Auto-Acquire Acquire All Records 4 Connection Export All Records

This will open the connection dialog.
Caonnection u

Please select available DK-5000 device from the list.

Wireless Coordinator Device

’{CHDDSE WIRELESS COORDINATOR DEVICE> v] [ R.Eflﬁhl

Wireless End Device

l 3
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2.2.2 From the Wireless Coordinator Device dropdown menu, select a coordinator device you

want to connect to.

Connection hod

Pleasze select available DE-3000 device from the list.

Wireless Coordinator Device

< CHOOSE WIRELESS COORDIMATOR DEVICE= ~ | | Refresh

< CHOOSE WIRELESS COORDIMATOR DEVICE= |

QK Cancel

The connection dialog will then load the end devices of the sel

ected coordinator device.

Connection pod

Pleasze select available DE-3000 device from the list.

Wireless Coordinator Device

’ Discovering Wireless End Device

QK Cancel

2.2.3 From the Wireless End Device dropdown menu, select the end device you to connect to

then click OK button.

Connection ot

Pleasze select available DE-3000 device from the list.

Wireless Coordinator Device

COMBG : Parent ~ | Refresh

Wireless End Device

‘Child -

QK Cancel

Click Cancel button to close the connection dialog without connecting to any device.
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2.2.4 When the software successfully connects to the selected device, the Title Bar will display the

Device Type, ID and COM Port as shown below.

File Device Window Help

‘ | Auto-Acquire ‘ ‘ 1| Acquire All

, Wirclss DK 5008

File Device Window Help

| Auto-Acquire l l |l Acquire All Records l | # Connection I ‘ Export All Records

Auto-Acquire | Records |

Format1 | Format 2 | HCL Display|

Last Update Time: 2017-01-09 15:02:48

Model: DK-5005A | Device ID: 000 | Records: 7
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Successful connection to a Type C device will show the Acquire Present page.

File Device Window Help

l | Acquire Present Data l l |1 Acquire All Records l \ ¥ Connection l ‘ Export All Records ‘

Present |

I Last Update Tirme:

Model: DK-5030C | Device ID: 001 | Records: 4

Successful connection to a Type D device will show the Auto Acquire page.

ireless DK-

File Device Window Help

l | Auto-Acquire l \ |l Acquire All Records l l /7 Connection I ‘ Export All Records ‘

Auto-Acquire |

I Status View | HCL Display

Last Update Time: 2017-01-09 15:07:00 W] standby B High [B Low

|| Model: DK-5030D | Device ID: 000 | Records: 0

— —
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2.2.5 |If attempting to connect a new device while there are Records from a different device on

display, a dialog will appear to confirm if Records will be saved before connecting to the new device.

=% Connect New Device Ed

Your record will be cleared if you connect to a new device.,
Do you wish to save before you proceed?

es Mo Cancel

Select Yes to save the displayed Records.
Select No to discard the Records on display and continue connecting to the new device.
Select Cancel to abort connection to the new device.

2.2.6 In cases where no DK-5000 device is detected, an error message will be shown.

>

Unable to detect a DE-3000 device. Please check device connection.

Error Code; 30

2.3 DISCONNECT A DK-5000 DEVICE

2.3.1 Click Device in the menu bar. And then select Disconnect (Device > Disconnect).

File [ Device | Window Help
.7 Device Settings 3
‘-#1 Connection Ctrl+ O ._”r_l Acquire All
4" Disconnect Ctrl+Shift+C  F
Aot i
gL Sync Time Ctrl+T
St 1= Edit Labels
L2 = Firmware Version Ctrl+R

A message will appear to confirm disconnection.

=2 Safe to Remove Hardware X

Device can now be safely rernoved from your system.
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Warning!

Do not physically disconnect the DK-5000 device from the wireless device without a
Disconnect command and confirmation that the device can be safely removed. This will
introduce a huge risk of the software not being able to detect re-connection of the DK-5000

device or new connections of new DK-5000 devices.
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DATA COMMUNICATION WITH DK-5000 DEVICE

3.1 AUTO-ACQUIRE PRESENT DATA

This function is available in Type A, Type B and Type D DK-5000 devices only. Software will
show the present data displayed on the DK-5000 device, and will automatically refresh every 1

second.

3.1.1 Click File in the menu bar, and then select Auto-Acquire (File > Auto-Acquire).

E Wireless DK-3000 Mieruzzo Basic Software

FFFE] Device Window Help

Il Auto-Acquire Ctrl+G

[lf|  Acquire All Records Ctrl+D

= Start Record Ctrl+5Shift+T

4= EndRecord Ctrl+Shift+M
Export All Records Ctrl+K

ﬂ_] Exit Ctrl+X

Or click Auto-Acguire button.

[ % Wireless DK-5000 Mieruzzo Basic Software - DK-5030D - 000 : COMA!

File Device Window Help

| Auto-Acquire ‘ ‘ |L] Acquire All Records ‘ ‘ 7 Connection Export All Records

3.1.2 A successful Auto-Acquire command will show the present data displayed on the DK-5000
device, and the display will be automatically updated every 1 second. The Last Update Time
of the display is also shown.

There are two display formats available. Click the corresponding radio button to select the

preferred display format.
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Format 1 shows the individual values of each Input on the left side, and the total of all Inputs

on the right side.

File Device Window Help

l | Auto-Acquire l I |11 Acquire All Records l l &7 Connection l ‘ Export All Records ‘

Aute-Acquire | Records |

I Format1 | Format 2 | HCL Display |

Last Update Time: 2017-01-09 15:11:56

Model: DK-50054A | Device ID: 000 | Records: 7

Format 2 shows the value of Input 1 on the left side, total and individual values of other

Inputs in the middle, and total of all Inputs on the right side.

ireless DK-:

File Device Window Help

l 1 Auto-Acquire l l |1l Acquire All Records l l ¥ Connection | ‘ Export All Records ‘

Auto-Acquire | Records ‘

Format1 | Fermat2 | HCL Display|

Last Update Time: 2017-01-0915:12:43

Model: DK-50054 | Device ID: 000 | Records: 7

=———
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For Type D, there is only one format for Auto-Acquire. A display legend is available to

File Device Window Help
l | Auto-Acquire l l |11 Acquire All Records l l 7 Connection I ‘ Export All Records ‘
Auto-Acquire ‘
I Status View | HCL Display
Last Update Time: 2017-01-09 15:07:00 B Standby (M| High (] Low

Model: DK-5030D | Device ID: 000 | Records: 0
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3.2

3.2.1

3.2.2

ACQUIRE PRESENT DATA

This function is available in Type C DK-5000 devices only. Software will show the present
data displayed on the DK-5000 device.

Click Eile in the menu bar, and then select Acquire Present Data (File > Acquire Present
Data).

Wireless DK-5000 Mieruzzo re -

File | Device Window Help

Il Acquire Present Data Ctrl+G

[lf|  Acquire All Records Ctrl+D

= Start Record Ctrl+Shift+T

45 End Record Ctrl+Shift+M
Export All Records Ctrl+K

B Exit Ctrl+X

or click Acquire Present Data button.

| | Acquire Present Data I ‘ ] Acquire All Records ‘ ‘ ' Connection

Export All Records

A successful Acquire Present Data command will show the present data displayed on the

DK-5000 device. Additionally, it will update the number of Records shown in the device

details.

Wireless DK-5000

File Device Window Help

l 1 Acquire Present Data l l [l Acquire All Records

# Connection l ‘ Export All Records ‘

Present |

Last Update Time: 2017-01-09 15:15:19

Medel: DK-5030C | Device ID: 001 | Records: 4
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3.2.

3.3

3 This function can be executed only when device is in Count Mode. If Acquire Present was

attempted while device is in Standby Mode, an error message will be shown.

=, Error
8

I{ ]I Device is on Standby Mode. Cannot display present data.

Error Code: 1

et

HISTORICAL COUNT LIST

This function is available for Type A, B and D DK-5000 devices. The software will show the

list of ongoing count values from DK-5000 device. The view will automatically take data from the

device every second for display according to user-set interval upon connection to the device.

3.3.1 To view the Historical Count List, click the HCL Display tab from the Auto Acquire view.

File Device Window Help

l | Auto-Acquire l l |l Acquire All Records l l /¥ Connection Export All Records

Auto-Acquire | Records |

Update Time Total Inputl Input 2 Input 3 Input 4 Input 5
1 2017-01-0915:17:42
2 2017-01-0915:17:43
3 2017-01-0915:17:44
4 2017-01-0915:17:45
5 2017-01-0915:17:46
6 2017-01-0915:17:47
7 2017-01-0915:17:48
8 2017-01-09 15:17:49
9 2017-01-0915:17:50

B T R R R N I B |
B S S S N S S S
WL W W W W W W
oo oo ooooo
oo oo oo ooo
oo oo oo ooo

Lo Jooonoeasarse 7 ¢ 3 o Jo o |

< [

| »

At Change @ Time |1 sec Start

Update Interval HCL Data Export

Aute Scroll

Model: DK-5005A | Device ID: 000 | Records: 7
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3.3.2 To start populating the list, select the Interval Type, either At Change or Time. If Time is
selected, the user needs to input the value in the textbox and select the unit of time (sec, min or
hr) from the dropdown menu and then click Start button.

Update Interval

() At Change (®) Time sec | | Start| Stop

Model: DK-5005A | Device |D: 000 | Records: 5

3.3.3 The default Interval Type is set to At Change which means the table will update once
there is a change in the current value displayed in the DK-5000 device.

If At Change is selected, the textbox for time input and the dropdown menu for unit will be
automatically disabled.

Update Interval
(®) At Change (O Time 1 sec Start | | Stop

Model: DK-50054 | Device |D: 000 | Records: 5

3.3.4 To stop the table from updating, click Stop button.

Update Interval

At Change Time SEC Start

Model: DK-50054 | Device |D: 000 | Records: 3

3.3.5 By default the History Count List table is set to Auto Scroll. This feature allows the table to
automatically scroll to the latest table item. To enable and disable this feature, click Auto
Scroll checkbox.

Clear HCL Data Export

[+] Auto Scroll

3.3.6 To clear the History Count List table, click Clear button.
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3.3.7 To export the table to Excel or CSV file, click the HCL Data Export button or right click on

the table and click HCL

Data Export.

File Device Window Help

| Auto-Acquire ] l |1l Acquire All Records | I ¥ Connection Export All Records
Auto-Acquire | Reco[ds|
Format1 | Format 2 | HCL Display ‘

Update Time Total Input1 Input 2 Input 3 Input 4 Input 5 .
17 2017-01-09 15:17:59 7 4 3 0 0 0
13 2017-01-09 15:18:00 7 4 3 0 1} 1}
13 2017-01-09 15:18:01 7 4 3 ] 1] 1]
20 2017-01-09 15:18:02 7 4 3 0 [t} [t}
21 2017-01-09 15:18:03 7 4 3 0 0 0
22 2017-01-09 15:18:04 7 4 3 0 1} 1}
23 2017-01-09 15:18:05 7 4 El 0 0 0
25 2017-01-09 15:18:07 7 4 3 0 L
26 2017-01-09 15:18:08 7 4 3 0 i} i}
27 2017-01-09 15:18:10 7 4 El 0 0 0
28 2017-01-09 15:18:11 7 4 3 0 [t} [t}
29 2017-01-0915:18:12 7 4 3 0 0 0
30 2017-01-09 15:18:13 7 4 3 ] 1] 1]
El 2017-01-09 15:18:14 7 4 El 0 0 0 E
32 2017-01-09 15:18:15 7 4 3 0 [t} [t}
33 2017-01-09 15:18:16 7 4 3 0 0 0
34 2017-01-09 15:18:17 7 4 3 ] 1] 1]
35 2017-01-09 15:18:18 7 4 El 0 0 0
36 2017-01-09 15:18:19 7 4 3 0 [t} [t}
37 2017-01-09 15:18:20 7 4 3 0 1} 1} |

< 1 | »

Update Interval Clear | [ HCL Data Export |
() At Change @ Time 1 Stop Auto Scroll

Model: DK-5005A | Device ID: 000 | Records: 7

3.4

ACQUIRE ALL RECORDS

This function enables the software to show all the records saved in the memory of DK-5000

devices.

spreadsheet or delete a specific Record.

All Record details can be viewed and there is also an option to export Records to a

3.4.1 Click Eile in the menu bar, and then select Acquire All Records (File > Acquire All

Records).

Wireless DK-5000

File | Device Window

Help

Il Auto-Acquire
Acquire All Records

Save Record
Export All Records
Exit

BDdHdE

Save Record Without Reset

Ctrl+G
Ctrl+D
Ctrl+Shift+T
Ctrl+Shift+M
Ctrl+K
Ctrl+X
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3.4.2

Or click Acquire All Records button.

File Device Window Help

| Auto-Acquire |£] Acquire All Records /¥ Connection Export All Records

A successful Acquire All Records command will show all the records saved in the memory of

the DK-5000 device. Additionally, it will update the number of Records shown in the
displayed device details.

For a Type A device, all Records are listed in a single table.

File Device Window Help
| Auto-Acquire l l | 1] Acquire All Records l l /7 Connection l l I Export All Records
|Auto-Acquire| Records |
Timestamp Total Inputl Input 2 Input 3 Input 4 Input 5
1 2016-01-1205:34:24 0 0 0 0 0 0
2 2016-01-1205:3514 0 0 0 0 0 0
3 2016-01-1205:3520 0 0 0 0 0 0
N 4 2016-01-1205:49:19 0 0 0 0 0 0
(| 5 2016-01-1205:58:45 0 0 0 0 0 0
6  2016-01-1205:5812 0 0 0 0 0 0
7 2016-01-1206:21:02 0 0 0 0 0 0
|
| [ 3
Model: DK-50054 | Device ID: 000 | Records: 7
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For Type B, Type C and Type D devices, each Record is shown as a separate table. Each

table shows a list of all the logs inside that Record.

# Connection l l

I5 Export All Records

Auto-Acquire | 2016-01-01 01:05:57 | 2016-01-01 01:07:10 | 2016-01-01 01:24:06 | 2016-01-01 02:50:35 | 2016-01-01 02:50:46 | 2016-01-01 02:50:51 | 2016-01-01 02:50:55 | 2016-012-01( ¢ | »

Input5

Input 5

Input 6 Input? Input & Input9
1] 0 Q 0
Input & Input7 Input & Input9
0 0 0 0
0 0 0 0

Input 10 Inpu

L} 0
»

Input 10 Inpu
0 0
0 0

L

E Export Record

File Device Window Help
|l Auto-Acquire l l |1l Acquire All Records ] \
Timestamp Total Inputl Input 2 Input 3 Input 4
2 2016-01-01 01:05:57 0O 0 0 0 0 0
| m |
| = Timestamp Total Inputl Input 2 Input3 Input4
W 1 2016-01-0101:05:39 0O 0 0 0 0 0
2 2016-01-01 01:05:57 O 0 0 0 0 0
[l
< m
Start Time: 2016-01-01 01:05:39
End Time: 2016-01-01 01:05:57
MNumber of Logs: 2
Model: DK-5030B | Device ID: 000 | Records: 79
b

3.4.3 The software will display messages for three (3) conditions that indicate the status of

available memory on the device.

3.3.4.1 No Records In Memory

A warning message will be displayed to indicate that Acquire All Records is attempted but

there are no Records saved in the device memory.

=2 Warning

Ma record found.

Warning Code: 4
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3.3.4.2 Device Memory Low

“Memory Low” message will be displayed if device memory usage is between 80% - 100%.

== Information Ed

| Device mermaory is LOW.,

3.3.4.3 Device Memory Full

“Memory Full” message will be displayed if 100% of device memory is used. This serves as
a warning to backup data by exporting to an .XLS or .CSV file, and free up device memory
by deleting old Records. When memory is full, the device will automatically delete the oldest
Record to free up memory when additional memory for new Records is needed.

2% Information >

| Device memory is FULL.
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3.4.4 If Acquire All Records is pressed while the Records in the device are already on display

because of a prior Acquire All Records command, the software will check if there are new

Records or if there are changes in the device. If the Records in the device do not match the
Records on display, a dialog will appear to confirm if Records will be saved before acquiring

Records.

=% Update Record >

&% There are changes made in the device and you may lose some records if you update.

WY Do youwish to save before you proceed?

es Mo Cancel

Select Yes to save the displayed Records. Follow the export procedure.
Select No to discard the Records on display and continue acquiring new Records.
Select Cancel to abort acquiring all Records.

3.5 DELETE A SPECIFIC RECORD IN DK-5000 DEVICE

3.5.1 To delete a specific record in a Type A device, right-click on the Record to be deleted, and

then select Delete Record.

File Device Window Help

| Auto-Acquire l l |1 Acquire All Records ] l /' Connection l | I Export All Records

| Auto-Acquwre‘ Records |

Timestamp Total Inputl Input 2 Input 3 Input 4 Input 5

fl 1 2016-01-1205:34:24 0 0 0 0 0 0 N
2 2016-01-1205:35:14 0 0 0 1] 0 0
3 2016-01-1205:35:20 0 0 1} [i] 0 1}
4 2016-01-1205:4%:19 0 0 0 1] 0 0
0 B A |
6 2016-01-1205:5%:12 0 0 0 0
7 2016-01-1206:21:02 0 0 [t}

Model: DK-5005A | Device ID: 000 | Records: 7
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To delete a Record in Type B, Type C and Type D devices, right-click on the Tab Title of the
Record to be deleted, and then select Delete Record.

File Device Window Help
|l Auto-Acquire l l |1 Acquire All Records l l  Connection l l I Export All Records
Auto-Acquire | 2016-01 7:10 | 2016-01-01 01:24:06 | 2016-01-01 02:50:35 | 2016-01-01 02:50:46 | 2016-01-01 02:50:51 | 2016-01-01 02:50:55 | 2016-01-01( ¢ |
& Delete Record
Timestamp Total Inputl Input2 Input 3 Input 4 Input 5 Input & Input 7 Input & Input 8 Input 10 Inpu
2 2016-01-01 01:05:57 0 0 0 0 0 0 0 0 0 0 0 0
a m | 3
W ‘ Tirmestamp Total Inputl Input2 Input 3 Input 4 Input 5 Input& Input7 Input & Inputd Input 10 Inpu
W 1 2016-01-0101:05:33 0 0 0 0 1] 0 0 0 0 0 0 1]
2 2016-01-0101:05:57 0 0 0 0 0 0 0 0 0 0 0 0
(|
« I v
Start Time: 2016-01-01 01:05:39
End Time: 2016-01-01 01:05:57 E Export Record
Mumber of Logs: 2
Model: DE-5030B | Device [D: 000 | Records: 79
S

3.5.2 A dialog will appear to confirm the requested command.

=% Confirm >

e
i 3

Are you sure you want to delete this record?

- A

3.5.3 Click OK to delete selected record. The following message will appear to confirm that the
Record was successfully deleted.

[z
et

—
2 e

Record was successfully deleted from the device.

~ 4
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3.5.4 Delete Record will not proceed if the Records in the device do not match the Records on
display. A dialog will appear to confirm if the display will be updated by an automatic

Acquire All Records command.

=% Cannot Delete Record Ed

There are changes to the device records.

JA Do you wish to update?

Select Yes to update display by acquiring all Records in the device memory.

Select No to abort Delete Record command.

3.6 CLEAR ALL DATA IN DK-5000 DEVICE

3.6.1 Click Device in the menu bar, select Device Settings, and then select Clear All Data

(Device > Device Settings > Clear All Data).

2%, Wireless DK-5000 Mieruzzo Basic Software - DK-50054 - 000 : COM42 ||
File [ Device | Window Help
¢ Device Settings k| [0 ClearAll Data  Ctrl+L
[ ﬁ Connection Ctrl+0 | x4 Set DeviceID Ctrl+I
j‘ Disconnect Ctrl+Shift+C
lm L SyncTime Ctrl+T
|7 EditLabels
C@ Firrnware Wersion Ctrl+R - Input 2 Input 3

3.6.2 A dialog will appear to confirm deletion of all records.

=2 Clear All Data oy

% Do youwish to clear all records in the device?

~ -
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3.6.3 Click OK to clear all Records in the device.
All the Records in the device will be deleted and the records displayed in the software will

also be cleared.

Note:
The DK-5000 device will proceed to Memory Recall Mode displaying “no data” to
indicate that the memory is cleared of all data.

3.6.4 For Type B, Type C and Type D devices, the Clear All Data feature cannot be used when
device is in Recording or Count Mode, respectively. If Clear All Data is attempted during
Recording or Count Mode, an error message will be shown.

| Device is on Recording mode, Cannot process your request.

Error Code: 5

3.7 SAVE RECORD FROM SOFTWARE

This feature allows the user to save the ongoing record to the device.

3.7.1 For Type A devices, there are two ways of saving a record. First is Save Record Without

Reset and the second is just Save Record. Save Record will reset the value on the device
upon saving. To save a record, select File from the menu bar and select which way you

want to save.

£, Wireless DK-5000 Mieruzzo Basic Software - DK-5
[File | Device Window Help

I Auto-Acquire Ctrl+G

||  Acquire All Records Ctrl+D

s Save Record Without Reset  Chrl+5hift+T

4= SaveRecord Ctrl+Shift+M

IF Export All Records Ctrl+K

& Exit Ctrl+X
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3.7.2 For Type B, C and D devices, if the device is on Stand By mode, select File from menu bar
and select Start Record. Once the device is on recording mode and the user wants to save
the current record, go to File and select End Record.

T — T —
é Wireless DK-3000 Mieruzzo Basic Software - DE-5

File | Device Window Help

Il Auto-Acquire Ctrl+G

|lf|  Acquire All Records Ctrl+D

= StartRecord Ctrl+Shift+T

#=| EndRecord Ctrl+Shift+M
Export All Records Ctrl+E

8] Bt Ctrl+X

Prompt that a record has been created.

=% Start Record Ed

@& Record Created

b - <

Prompt that a record has been saved.

2% End Record >

.

Record saved.

~ 4

If the user tries to start a record while on recording mode, the software will prompt the user that the
device is on recording mode and cannot start a new one.

(=]
=5 Error >

l{’ \]I Device is on Recording mode. Cannot process your request.

- 4

Error Code: 5
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If the user tries to start a record while on standby mode, the software will prompt the user that the
device is on standby mode and cannot start a new one.

== Error oy

Start Record is applicable only when device is on Standby mode.

Error Code; 16

If the user tries to end a record while on standby mode, the software will prompt the user that the
device is on standby mode and cannot end a non-existing record.

2= Error >

End/5ave Record is applicable only when device is on Recording mode or Count
mode

Error Code; 16
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EDITING LABELS

4.1 EDIT LABELS
This function allows the user to edit the default Input labels. These labels will be used in the

Auto-Acquire and Acquire All tabs when displaying data from the device and also in the exported

file.

4.1.1 To edit Input labels, click Device from the menu bar then select Edit Labels.

e —y
é Wireless DK-3000 Mieruzzo Basic Software - D
File [Device | Window Help
7 Device Settings [
‘,ﬁ" Connection Ctrl+ O
&Y Disconnect Ctrl+Shift+C
Aut
g Sync Time Ctrl+T
Fo |5 Edit Labels
L. _{ﬁ Firrnmware Version Ctrl+R

4.1.2 The Labels dialog will be shown and the textbox for each label will be enabled depending on

the number of Inputs of the connected device.

Labels S|
1 | Machinel 2 | Machine2 3 | Machine3 4 | Machine4 5
6 | InputB 7 | Input? 8 | Inputd 9 | Input8 10 | Input10
11 | Inputll 12 | Inputl2 13 | Inputl3 14 | Input14 15 | Inputls |
16 | Inputl6 17 | Inputl7 18 | Inputl8 19 | Input19 20 | Input 20
21 | Input2l 22 | Input22 23 | Input23 24 | Input 24 25 | Input 25
26 | Input26 27 | Input 27 28 | Input 28 29 | Input29 30 | Input30

lImport] [Exportl l Reset ]

In this example, the connected device has 5 Inputs.

Click OK button to apply the changes and Cancel button to discard the changes and close

the Labels dialog.

4.1.3 Upon applying the changes in Input labels, the Auto-Acquire and Acquire All Records view
will be updated.
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Auto-Acquire View:

ireless DK-!

File Device Window Help

l | Auto-Acquire l l L] Acquire All Records ] l 7 Connection | ‘ Export All Records ‘

Auto-Acquire ‘ Records |

I Formatl | Format 2 I HCL Display

Last Update Time: 2017-01-09 15:34:03

Model: DK-50054 | Device ID: 000 | Records: 7

= — —

Acquire All Records View:

File Device Window Help
l | Auto-Acquire l l |1l Acquire All Records ] l 7 Connection l l |5 Export All Records ]
| Auto-Acquire | Records |
Timestamp Total Machinel Machine2 Machine3 Machined Machine5
1 2016-01-1205:34:24 0 0 0 0 0 0
I 2 2016-01-1205:35:14 0 0 0 0 0 0
f 3 2016-01-1205:35:20 0 0 0 0 0 0
4 2016-01-120549:19 0 0 0 0 0 0
| 5 2016-01-1205:58:45 0 0 0 0 0 0
6 2016-01-120553:12 0 0 0 0 0 0
| 7 2016-01-1206:21:02 0 0 0 0 0 0
q [ m 3
Model: DK-5005A | Device ID: 000 | Records: 7
_ ||
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4.2 EXPORT LABELS
This allows the user to save the labels into a CSV file. This CSV file can be shared and

imported in case the user wants to use the labels again.

4.2.1 To export labels, open the Labels dialog. Go to Device from the menu bar then click Edit

Labels.

Labels (e e
1 | Machinel 2 | Machine2 3 | Machine3 4 | Machine4 5
6 | Input@ 7 | Input? 8 | Inputd 9 | Inputd 10 | Inputl0
11 | Inputll 12 | Inputl2 13 | Inputl3 14 | Input14 15 | Inputls
16 | Inputl6 17 | Inputl7 18 | Inputl8 19 | Input19 200 | Input 20
21 | Input2l 22 | Input 22 23 | Input 23 24 | Input 24 25 | Input 25
26 | Input26 27 | Input27 28 | Input 28 29 | Input29 30 | Input30

’Impor‘t] ’Export] ’ Reset ]

4.2.2 After editing the labels, click Export button and the Save Dialog will show up with a default
file name ‘Input_Labels’. The user can change the file name then select the location and
click SAVE to save the CSV file.

=% Save As *
4 i « My Documents > DE5S000 w | Search DK5000 p=
Organize « Mew folder = o
A - - -
v E This PC Mame Date modified Type
I Desktop Me iterns match your search,
» [ Documents
* Downloads
J) Music
&= Pictures
B Videos
w = Windows7 Q5 (C) N
File name: | Counter_Labels -
Save as type: | Comma-Separated Yalue (*.csv) w

# Hide Folders Cancel
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4.3 IMPORT LABELS

Once the CSV file of the labels has been exported, the user can import it and use it
again.

4.3.1 To import labels, open the Labels dialog. Go to Device from the menu bar then click
Edit Labels.

4.3.2 Click Import button then select the CSV file and click Open. The labels from the CSV
file will be displayed in the Labels dialog.

£ Open x
= v s This PC » Documents » DE5000 w Search DK5000 2
Organize » Mew folder == ~ [H 0
s
A e .
v [ This PC Mame Date modified Type
B Desktop IE_L,] Input_Labels 53,2016 3:00 PM Microsoft
> @ Documents
* Downloads
J) Music
=/ Pictures
g Videos
i Windows7_05 (C:)
3f2e28ecObfIeleldfy.
ADFF78160D6FOFBEFC » « >
File name: |Input_Labels V| e ~
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EXPORTING RECORDS TO A FILE

5.1 EXPORT A SPECIFIC RECORD

This function enables saving a copy of selected Record to a spreadsheet. This function is
available in Type B, Type C and Type D DK-5000 devices only. For Type A devices, please use the

Export All Records function.

5.1.1 To export a specific individual Record, right-click on the page to be exported, and then select

Export Record or click the Export Record button, which is found on the lower-right corner

of the page.

Wirel Basic Soft - DK-5020B - 000 : COM4.

File Device Window Help

1 Auto-Acquire l l |1 Acquire All Records ] I 7 Connection l l I Export All Records

| 2016-01-01 01:05:57  2016-01-01 01:07:10 | 2016-01-01 01:24:06 | 2016-01-01 02:50:35 | 2016-01-01 02:50:46 | 2016-01-01 02:50:51 | 2016-01-01 02:50:55 | 2016-01-01 02:51:03 | 20160 « | >

Timestamp Total Machinel Machine2 Machine3 Machined Machine5 Inputé Input? Input 8 Input9 Input 10 Inpu

(| 2 2016-01-01 01:07:10 0O 0 0 0 0 0 0 1] 1] 0 0 0 |
o T | 3
‘ Timestamp Total Machinel Machine2 Machine3 Machine4 Machine5 Inputé Input? Input & Input9 Input 10 Inpu

1 2016-01-0101:06:04 0O 0 0

0 0 0 0 0 0 0 0 0
o oo Jo o Jo___Jo___lo___Jo___]o0]
port Recor

« 1 »

Start Time: 2016-01-01 01:06:04
End Time: 2016-01-01 01:07:10 E Export Record
Number of Logs: 2

Model: DK-5030B | Device ID: 000 | Records: 81
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5.1.2 You can choose to save the record as an MS Excel Workbook (.XLS) or a comma separated
value (.CSV) file.

2 Save As b
« v A » This PC » Desktop » DK 3000 v O Search DK 3000 P
Organize « Mew folder == - 9
& OneDrive 2 Mame Date modified Type 5id
& OneDrive - Line S Mo items match your search,
E This PC
[ Desktop
Documents
; Downloads
J& Music
&= | Pictures
E Videos ol s
File name: | 102_20161005114951_20161005114958 -
Save as type: | Excel Workbook (*.xls) w
# Hide Folders Cancel

The default filename to be used follow the format below:

Device ID start timestamp end timestamp.xls

Device ID start timestamp end timestamp.csv

5.2 EXPORT ALL RECORDS

5.2.1 To export all records displayed, click File in the menu bar, and then select Export All
Records (File > Export All Records).

File | Device Window Help

Il Auto-Acquire Ctrl+G
[{f] Acquire All Records Ctrl+D
=g Start Record Ctrl+5Shift+T
4= EndRecord Ctrl+Shift+M
I} Export All Records Ctrl+K
iJ Exit Ctrl+X
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Or click Export All Records button.

File Device Window Help

| Auto-Acquire L Acquire All Records 4 Connection IE Export All Records

5.2.2 You can choose to save the Records as an MS Excel Workbook (.XLS) or a comma
separated value (.CSV) file.

.ﬁ'. Save fs

= v A > ThisPC » Desktop » DK 35000 AN Search DK 5000 2

Organize - Mew folder A== 0

/& OneDrive " Name Date modified Type

& OneDrive - Line 5¢ Mo iterns match your search.

[ This PC
B Desktop

AL

=| Documents

; Downloads

J) Music

=/ Pictures

m Videos =

G102 20161005134203
Save as type: | Excel Workbook (*.xls)

» Hide Folders Cancel

The default filename to be used follow the format below:

Device ID date & time of export.xls

Device ID date & time of export.csv

If exported to Excel, each Record will be on a different sheet in one Excel file, while, if
exported in CSV, each Record will be stored as individual CSV files.
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CHANGING DEVICE SETTINGS

6.1 SET DEVICE ID

The software can be used to change the Device ID of the connected DK-5000 device. The

Device ID is a 3-digit user-programmable number which is used to identify different DK-5000

devices.

6.1.1 Click Device in the menu bar, select Device Settings, and then select Set Device ID

(Device > Device Settings > Set Device ID).

=3 Wireless DK-5000 Mieruzzo Basic

File [De'.rice] Window Help

¢ Device Settings b | [0 Clear All Data  Cirl+L
ﬁ Connection Ctrl+ 0 _I-;,.j Set Device ID Ctrl+1
ﬁi Disconnect Ctrl+5hift+C
201 @ | Sync Time CtrleT -01-01 01:24:06 | 2016-01-01 02:5
|7 Edit Labels
G@ Firrnmware Version Ctrl+R 1
P P | Edarlima 7 Edarlim,

6.1.2 Type the desired 3-digit Device ID.

Set Device D pod

Please enter the device ID:

102

Cancel

6.1.3 Click OK to save selected Device ID.
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6.1.4 For Type B and Type C devices, this feature cannot be used when in Recording or Count
Mode, respectively. If the Device ID is attempted to be changed during Recording or Count

Mode, an error message will be shown.

= Error Ed

Device is on Recording mode. Cannot process your request.

Error Code: 5

6.2 SYNCHRONIZE DK-5000 DEVICE TIME WITH SYSTEM TIME

6.2.1 Click Device in the menu bar, and then select Sync Time (Device > Sync Time).

é Wireless DK—Sﬂm
File | Device | Window Help
¢ Device Settings L
[ j Connection Ctrl+ O
4" Disconnect Ctrl+Shift+C
lﬁ (g Sync Time Ctrl+T
|7 Edit Labels
:@ Firrnware Version Ctrl+R

6.2.2 A dialog will appear that shows the current time of the PC.

Sync Time >

Tirne on device will be synced with time on computer,

2016-10-05 13:48:48

Cancel

6.2.3 Click OK to sync the time of DK-5000 device to system time.
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6.2.4 For Type B and Type C devices, this feature cannot be used when in Recording or Count
Mode, respectively. If time is attempted to be synced during Recording or Count Mode, an

error message will be shown.

(=]
=5 Error >

| Device is on Recording mode. Cannot process your request.

Error Code: 5

MISCELLANEOUS FUNCTIONS

7.1 VIEW DEVICE FIRMWARE VERSION

7.1.1 Click Device in the menu bar, and then select Firmware Version (Device > Firmware

Version). It will show the firmware version of the connected device.

[=31] - -
=5 Firmware Version X

| Mieruzrzo Series Wireless/ Sensor Device firmware v.1.0 build 020
DHeC- 5000 firrmmware w.11.4
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7.2 CHECK FOR SOFTWARE UPDATES

7.2.1 Click Help in the menu bar, and then select Check for Updates (Help > Check for Updates).

It will automatically search for available software updates.

£% Contacting Software Sites O >

Contacting Software Sites

[] Always run in background

Run in Background Cancel Details = »

If no updates are available, it will show a message prompt below.

=% Information >

Mo updates were found,

7.2.2 If there is no internet connection or if the software cannot connect to the update server, an

error message will appear.

F© N
=% Problem Occurred E@ﬂ

N h 'Contacting Software Sites' has encountered a problem.

" Unknown Host: http://software.line.com.ph/dk5000-release/repositony/content.xml

ok || Details>> |
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7.3

7.3.1

7.4

7.4.1

VIEW SOFTWARE INSTRUCTION MANUAL

Click Help in the menu bar, and then select Manual (Help > Manual). It will open a copy of

the Wireless DK-5000 Mieruzzo Basic Software User’s Manual.

VIEW SOFTWARE VERSION AND INSTALLATION DETAILS

Click Help in the menu bar, and then select About Wireless DK-5000 Mieruzzo Basic

Software (Help > About Wireless DK-5000 Mieruzzo Basic Software). It will show the following

window which tells the software build version and an option to see the software installation

details.
=% About Wireless DK-5000 Mieruzzo Basic Software =] 2%
0 0 Wireless DK-5000 Mieruzzo Basic Software
Version: 1.0.0.435
MIERUZZO

o von ,ﬂ. () 2016 Line Seiki Co., Ltd. Mieruzzo is a registered trademark of Line
———— Seiki Co., Ltd. All rights reserved, All other tradermarks or trade names
; I_ﬂ_ﬂ_ﬂ_ﬂ_ﬁ are properties of their respective owners.

WWW.LITIEMNIZZO.COM

’Installaticm Details

-
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8 FREQUENTLY ASKED QUESTIONS

1. Why do | get a "no DK-5000 device detected" message when I click Connection even when my device is
visibly connected?

These are common reasons for not detecting a DK-5000 device, and possible solutions:

e Make sure your device is connected and turned ON. You cannot connect if the device is turned off.

e Make sure that the PC recognizes your device. If this is the first time you connected a DK-5000
device, it'll take some time for windows to install the appropriate driver. Please note that our
software installation contains the drivers necessary for your DK-5000.

e We received reports that changing the USB port to connect to help with the OS recognizing the

device.

2. Why do | get an "unknown device" error in device manager when | connect the wireless device to my
PC?
These are 2 possible reasons for unknown device error:
e Driver installation. Make sure that you've properly followed the software and driver installation.
e Windows USB Stack issue. This is an issue with Windows' USB stack. Try disconnecting then

reconnecting the device, or restarting your PC.

3. Why can’t | sync the time on my DK-5000 device to the PC time?
It is possible that your device is in Recording or Count Mode. There are restrictions to setting the time
when the device is not on Standby Mode (for Type B and C devices). Make sure you go to Standby Mode

first before syncing the time.

4. Why can’t | change the time on my DK-5000 device?
It is possible that your device is in Recording or Count Mode. There are restrictions to setting the
time when the device is not on standby mode (for Type A and B). Make sure you go to standby mode

first before setting the time.

5. Why can’t | change the Device ID on my DK-5000 device?
You cannot change the Device ID on your DK-5000 device if it is connected to the Wireless DK-5000

Mieruzzo Basic Software. Use the Set Device ID function of the software to change the Device ID.

y el
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6. | already disconnected the device from the software, why can’t | change the Device ID on my DK-5000
device?

It is possible that your device is in Recording or Count Mode. There are restrictions to editing the

Device ID when the device is not on Standby Mode (for Type B and C devices). Make sure you go to

Standby Mode first before changing the Device ID.

7. Why are my old records missing in the device memory?
Your DK-5000 has limited memory and will erase the earliest record to free up space for new ones. To
avoid this, please refer to the manual and save your records using our Wireless DK-5000 Mieruzzo Basic

Software before clearing the device memory.

8. Why don’t | get back to the default folder DK-5000 when | export my records?
We have an initial folder DK-5000, but the software remembers the last folder where the user saved last
export. You may choose not to use the DK-5000 folder. But you should be able to find it again under your

Documents folder.

For more information, please visit www.lineseiki.com.

This manual was last revised March 07, 2017
*Contents are subject to change even without prior notice.
All Rights Reserved, Copyright © 2015, LINE SEIKI CO., LTD.
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